SCHOLARSHIP PROGRAM
Policies and Procedures
A. Purpose & Scope

Purpose: To ensure that Nation Members have an opportunity to further their education by providing financial aid through a Scholarship Program.

Scope: All Enrolled Members of the Oneida Indian Nation, which is located in New York. Students must have an enrollment number in order to apply.

B. General Policy

1. Any enrolled Member of the Oneida Indian Nation is eligible to file an application to receive financial aid from the Oneida Indian Nation to pursue post-secondary education in a degree program at a regionally, nationally, or internationally accredited institution, or a certificate program from a regionally, nationally, or internationally accredited institution.

2. The amount of the awards will be set forth in a payment schedule to be reviewed and approved annually by the Oneida Indian Nation Council, prior to August 1 of the academic year. Scholarship awards at the undergraduate level and up include two payment types: a scholarship and a student stipend.

3. The scholarship year shall begin anytime throughout the year and shall consist of semesters, trimesters, quarters, or other set number of terms as determined by the academic institution’s Registrar’s Office and academic calendar. Students must submit an application for each term of funding throughout the academic year. All required documents must be submitted. Applications for each term are accepted up until the last day of the corresponding term. Date of last day of term is determined by the institution’s official academic calendar. Applications will not be processed after the term has ended.

4. All certificate, vocational, undergraduate, and graduate students demonstrating need as indicated on the Oneida Indian Nation Education Assistance Request form by the school’s Financial Aid Office and academic calendar. Students must submit an application for each term of funding throughout the academic year. All required documents must be submitted. Applications for each term are accepted up until the last day of the corresponding term. Date of last day of term is determined by the institution’s official academic calendar. Applications will not be processed after the term has ended.

5. Full-time and part-time undergraduate and graduate students may also be eligible to receive a stipend award to offset living and other school related expenses. Stipends vary depending on academic enrollment status, marital status, number of dependents, and living situation, and are sent directly to the student. Vocational students enrolled in 12+ clock hours per week who ALSO have a lease or mortgage payment may eligible for a stipend. Full- time or part-time vocational students who do not have a rent or mortgage payment, are not eligible for a stipend award. (Refer to Charts J, K, L, M on pages 15-22). Students can request to receive stipend installments in the form of mailed checks or direct deposit.

6. Undergraduate and Graduate students who are participants in the Scholarship Program may be eligible to receive a Travel Expense Award. Only one award PER LEVEL. (See Scholarship Program Travel, Moving, and Emergency Expense Policy booklet for more details)

7. Full-time undergraduate students earning Bachelor’s Degrees and all Full-Time graduate students who are participants in the Scholarship Program may be eligible to receive a Travel Expense Award. Applies to Bachelor’s Degree, Master’s Degree, and Doctorate Degree students only. (See Scholarship Program Travel, Moving, and Emergency Expense Policy booklet for more details)

8. All students who are participants in the Scholarship Program may be eligible to apply for an Emergency Expenses loan through use of their Member Trust Fund. Students must inform Scholarship Coordinator as soon as possible to seek approval from Council for funds and later provide relevant supplemental documentation. (See Scholarship Program Travel, Moving, and Emergency Expense Policy booklet for more details)

9. The Education Department is not associated with Member quarterly distributions. A list of students participating in the Scholarship Program who have turned in all required scholarship documents is sent to Member Benefits quarterly. Please contact the MBO directly with any questions regarding distribution or distribution eligibility.

10. The Education Department is not permitted to speak with parents or guardians of the students participating in the Scholarship Program regarding the students’ scholarship, documents, repayment applications, or any other matter, if the student is 18 years or older. All students 18+ years old should contact and communicate with the Scholarship Program Coordinator directly. Parents or guardians may communicate directly with Scholarship Program Coordinator in regards to student if student is 17 years old or younger.
C. Application Process and Procedures

1. In order to apply, students must complete the Oneida Indian Nation Post-Secondary Scholarship Application at https://oneidaindiannation.submittable.com/submit. Create a Submittable account and click “Login.” If you do not have access to a computer or Internet access, please contact the Scholarship Program Coordinator.

2. ALL students at all levels are required to have an Oneida Indian Nation Education Assistance Request Form completed and sent to Scholarship Program Coordinator. Students fill out the top portion of the form and then give the form to their Financial Aid Office to fill out the middle portion. Students must request that the Financial Aid Office e-mail the Scholarship Coordinator the completed form directly.

3. ALL students at all levels are required to have an Oneida Indian Nation Education Assistance Request Form completed and sent to Scholarship Program Coordinator. Students fill out the top portion of the form and then give the form to their Financial Aid Office to fill out the middle portion. Students must request that the Financial Aid Office e-mail the Scholarship Coordinator the completed form directly.

4. If you apply for the academic year (2 terms), you must submit your application for the entire academic year (2 terms) with all required funding permits.

5. Failure to provide proof (BIE award or denial letter) will result in a decrease in the scholarship and stipend award. Deductions for failing to apply may vary upon the amount of the student’s previous academic year’s total deduction amount. If applicable, half is deducted from the student scholarship and half is deducted from the student stipend.

6. Students should verify with their school’s Financial Aid Office whether or not they are eligible for Financial Aid. If students have loans that are in delinquency to Scholarship Program Coordinator.

7. All full-time AND part-time matriculated vocational AND undergraduate students attending school in New York State shall be required to apply for New York State Indian Aid. New York State Indian Aid Applications must be completed in IN FULL, twice a year.

8. The Education Department will verify the eligibility of the applicant by checking the applicant’s previous transcript to determine that the term is a full term and in full attendance. Contributions of student/spouse/family and any education loans will not be factored into scholarship amount.

9. The Education Department will verify completion of any previous financial need assessment and notify students if an update is required.

10. The Education Department requires that all applicants verify that any required repayments have been received in full.

11. The Education Department will verify the eligibility of the applicant by checking the applicant’s previous transcript to determine that the term is a full term and in full attendance. Contributions of student/spouse/family and any education loans will not be factored into scholarship amount.

12. In order to have the form completed and sent to the Scholarship Coordinator, students may be required to complete their institution’s FAFSA release Form. This form can be obtained by searching “[name of the student’s institution] + FAFSA Release Form” on the student’s website for the form. Follow instructions on FAFSA Form. E-mail the completed FAFSA Form – granting Scholarship Program Coordinator permission to access financial aid information – with completed top portion of Oneida Indian Nation EAR Form, to the school’s Financial Aid Office. Request that the middle portion of the EAR Form be completed and sent directly to Scholarship Coordinator by the Financial Aid Office.

13. Failure to provide proof may vary upon the amount of the student’s previous academic year’s total deduction amount. If applicable, half is deducted from the student scholarship and half is deducted from the student stipend.

14. Applications are required to be completed in full with all corresponding documents attached and e-mailed to doi-bie-higher-education-grant@doimspp.onmicrosoft.com with Scholarship Program Coordinator Cc’d on the same e-mail.

15. Students fill out and submit the top portion of the Scholarship Program Coordinator. Students must request that the Financial Aid Office e-mail the completed form and then give the form to their school’s Financial Aid Office to fill out the middle portion. Students must request that the Financial Aid Office e-mail the Scholarship Coordinator the completed form directly.

16. Applications are required to be completed in full with all corresponding documents attached and e-mailed to the e-mail indicated on the New York State Indian Aid Application with Scholarship Program Coordinator + Cc’d on the same e-mail.

17. If application is mailed instead of e-mailed, send through certified mail to ensure proof of arrival and safe receipt.

18. Contributions of student/spouse/family and any education loans will not be factored into scholarship amount.

19. Education Department requires submittal of all of the REQUIRED documents on the Required Documents List 5-9 for a complete Scholarship Award and Stipend Award application.

D. Verification

1. The Education Department will verify enrollment for each application through the Member Benefits Office.

2. The Education Department will verify financial need of the applicant by examining the financial aid information regarding other sources of funds.

3. The Education Department will verify the eligibility of the applicant by checking the applicant’s previous transcript to determine that the term is a full term and in full attendance. Contributions of student/spouse/family and any education loans will not be factored into scholarship amount.

4. The Education Department will verify the eligibility of the applicant by verifying that any required repayments have been received in full by the Oneida Indian Nation (if applicable).

5. The Education Department will verify completion of any previous financial need assessment and notify students if an update is required.

6. The Education Department will note all verifications on the review sheet.

7. Contributions of student/spouse/family and any education loans will not be factored into scholarship amount.

8. Education Department requires submittal of all of the REQUIRED documents on the Required Documents List 5-9 for a complete Scholarship Award and Stipend Award application.
E. Scholarship Application Required Documents List:
The Oneida Indian Nation Education Department requires submittal of documents for a complete Scholarship application.

- Internal documents are documents provided by the Nation to the student to complete and upload to the online application as applicable.
- External documents are documents students must obtain independently either from their educational institution or other relevant/applicable outside entity and upload to the online application as applicable.

Internal Oneida Indian Nation Scholarship Application:

- Letter from employer or academic advisor stating how course relates to student’s professional or academic enhancement/adancement.
- Copy of most recent paystub (every term…with dates, times, credit hours, professors, and locations—calendar versions not accepted)
- Proof of application to the BIE Higher Education Grant - Full-time students only (applicable to some vocational programs; if unsure of eligibility, contact Scholarship Program Coordinator)
- Acceptance Letter (if applicable)
- Enrollment Verification Forms - mid-year (if applicable)
- Acceptance Letter (first time applicants, first term of funding system)

External documents are documents students must obtain independently either from their educational institution or other relevant/applicable outside entity and upload to the online application as applicable:

- Copy of marriage certificate and proof of dependents
- Copy of student or spouse’s pay-stub (past-time students only; if applicable)
- Enrollment Verification Forms on November 15th for the Fall term and on February 15th and May 15th for the Spring term (if making changes through any term of other type of academic calendar system)
- Acceptance Letter for first time applicants, first term of funding toward new degree, or transfer students
- Term Bill (every term)

ii. Vocational Level: Trade School and Certificate Programs

- Completed Education Assistance Request Form: Students fill out the top, then give to school’s Financial Aid Office/Billing Office to fill out the middle, and ask that office to e-mail completed form directly to the Scholarship Program Coordinator.
- Completed Oneida Indian Nation Education Department Student Consent to Release Information Form
- Direct Deposit Form and Official Bank Letter/ Voided Check, if direct deposit for stipend is preferred.
- Acceptance/Registration Letter (1st term of funding only)
- Term Bill (every term)
- Term Class Schedule (every term…with dates, times, credit hours, professors, and locations—calendar versions not accepted)
- Copy of lease from parents or family members are not accepted
- Official Transcript from the term of attendance prior (every term, or if official transcript is unavailable, a direct e-mail from each instructor to Scholarship Program Coordinator with student’s grade every 30 weeks until completion of program)
- Copy of student’s FAFSA Student Aid Report (if applicable; some trade/vocational programs are not eligible for FAFSA. If program is eligible, student is required to apply. Only needs to be submitted once per academic year)
- Instructions on how to view/download SAR can be found here: https://studentaid.gov/undergraduate/ Click “Print” to drop down box where printer comes up and choose “Save as PDF” to computer: then submit to Scholarship Program.
- Copy of Lease/Mortgage and most recent utilities bill (if applicable)
- Copy of Marriage Certificate & proof of dependents (if applicable)
- Copy of student or spouse’s pay-stub (past-time students only; if applicable)
- Enrollment Verification Forms on November 15th for the Fall term and on February 15th and May 15th for the Spring term (if making changes through any term of other type of academic calendar system)
- Acceptance Letter for first time applicants, first term of funding toward new degree, or transfer students
- Term Bill (every term)

Documents must be submitted for every term of application, unless otherwise specified. Students must request an official transcript be sent directly to the Scholarship Program Coordinator at the end of every term. Please note that leases from parents or family members are not accepted.

i. Other Certificate (non-vocational), Workshop, Seminar Programs

- Completed Education Assistance Request Form: Students fill out the top, then give to school’s Financial Aid Office/Billing Office to fill out the middle, and ask that office to e-mail completed form directly to the Scholarship Program Coordinator.
- Completed Oneida Indian Nation Education Department Student Consent to Release Information Form
- Direct Deposit Form and Official Bank Letter/ Voided Check, if direct deposit for stipend is preferred.
- Acceptance/Registration Letter (1st term of funding only)
- Term Bill (every term)
- Term Class Schedule (every term…with dates, times, credit hours, professors, and locations—calendar versions not accepted)
- Letter from employer or academic advisor stating how course relates to student’s professional or academic enhancement/adancement.
- Copy of most recent paystub (if applicable)
- Enrollment Verification Forms midway through program, if the program is more than 2 months long.
- Copy of certificate or verification of completion when completed.

- Documents must be submitted for every term of application, unless otherwise specified. Students must request an official transcript be sent directly to the Scholarship Program Coordinator at the end of every term. Please note that leases from parents or family members are not accepted.

• Documents must be submitted for every term of application, unless otherwise specified. Students must request an official transcript be sent directly to the Scholarship Program Coordinator at the end of every term. Please note that leases from parents or family members are not accepted.

•External documents are documents students must obtain independently either from their educational institution or other relevant/applicable outside entity and upload to the online application as applicable.
•Internal documents are documents provided by the Nation to the student to complete and upload to the online application as applicable.

http://scholarshipformsandapplications/applications are accessible online at https://www.oneidaindiannation.com/Indian Higher Education Grant Bureau of External scholarship/stipend awards the following documents for a complete

Scholarship Application Required

E. Scholarship Application Required Documents List:

The Oneida Indian Nation Education Department requires submittal of documents for a complete Scholarship application. If you have difficulties accessing scholarship program forms and applications, please contact the Scholarship Program Coordinator.

- External documents are documents students must obtain independently either from their educational institution or other relevant/applicable outside entity and upload to the online application as applicable.
- Internal documents are documents provided by the Nation to the student to complete and upload to the online application as applicable.

External documents are documents students must obtain independently either from their educational institution or other relevant/applicable outside entity and upload to the online application as applicable.

- Letter from employer or academic advisor stating how course relates to student’s professional or academic enhancement/adancement.
- Copy of most recent paystub (every term…with dates, times, credit hours, professors, and locations—calendar versions not accepted)
- Proof of application to the BIE Higher Education Grant - Full-time students only (applicable to some vocational programs; if unsure of eligibility, contact Scholarship Program Coordinator)
- Acceptance Letter (if applicable)
- Enrollment Verification Forms - mid-year (if applicable)
- Acceptance Letter (first time applicants, first term of funding system)

External documents are documents students must obtain independently either from their educational institution or other relevant/applicable outside entity and upload to the online application as applicable:

- Copy of marriage certificate and proof of dependents
- Copy of student or spouse’s pay-stub (past-time students only; if applicable)
- Enrollment Verification Forms on November 15th for the Fall term and on February 15th and May 15th for the Spring term (if making changes through any term of other type of academic calendar system)
- Acceptance Letter for first time applicants, first term of funding toward new degree, or transfer students
- Term Bill (every term)

Documents must be submitted for every term of application, unless otherwise specified. Students must request an official transcript be sent directly to the Scholarship Program Coordinator at the end of every term. Please note that leases from parents or family members are not accepted.
iii. Undergraduate Level: Associate and Bachelor’s Degrees

- Completed Education Assistance Request Form: Students fill out the form to apply for financial aid. This application must be submitted directly to the Scholarship Program Coordinator.
- Completed Oneida Indian Nation Education Department Student Consent to Release Information Form.
- Direct Deposit Form and Official Bank Letter/Voided Check. For full-time students only.
- Proof of application to the BIE Higher Education Grant. Full-time students only.
- Acceptance Letter (for 1st time applicants, 1st term of funding applicable)
- Term Bill (every term)
- Term Class Schedule (every term...with dates, times, credit hours, professors, and locations—calendar versions not accepted)
- Official Transcript from the term of attendance prior (every term, or if official transcript is unavailable, a direct e-mail from each instructor to Scholarship Program Coordinator with student’s grade every 16 weeks until completion of program)
- Copy of student’s FAFSA Student Aid Report (if applicable; some trade/vocational programs are not eligible for FAFSA. If program is eligible, student is required to apply. Only needs to be submitted once per academic year)
- Copy of student’s FAFSA Student Aid Report if direct deposit for stipend is preferred.
- Acceptance Letter (for 1st time applicants, 1st term of funding toward new degree, or transfer students)
- Official Transcript from the term of attendance prior (every term...with dates, times, credit hours, professors, and locations—calendar versions not accepted)
- Acceptance Letter (for 1st time applicants, 1st term of funding toward new degree, or transfer students)
- Copy of Marriage Certificate & proof of dependents (if applicable)
- Official Transcript from the term of attendance prior (every term, or if official transcript is unavailable, a direct e-mail from each instructor to Scholarship Program Coordinator with student’s grade every 16 weeks until completion of program)

iv. Graduate Level: Master’s Degree

- Completed Education Assistance Request Form: Students fill out the form to apply for financial aid. This application must be submitted directly to the Scholarship Program Coordinator.
- Completed Oneida Indian Nation Education Department Student Consent to Release Information Form.
- Direct Deposit Form and Official Bank Letter/Voided Check. For full-time students only.
- Acceptance Letter (for 1st time applicants, 1st term of funding toward new degree, or transfer students)
- Completed Education Assistance Request Form:
- Term Bill (every term)
- Term Class Schedule (every term...with dates, times, credit hours, professors, and locations—calendar versions not accepted)
- Copy of student’s FAFSA Student Aid Report (if applicable; some trade/vocational programs are not eligible for FAFSA. If program is eligible, student is required to apply. Only needs to be submitted once per academic year)
- Copy of student’s FAFSA Student Aid Report (if applicable; some trade/vocational programs are not eligible for FAFSA. If program is eligible, student is required to apply. Only needs to be submitted once per academic year)
- Acceptance Letter (for 1st time applicants, 1st term of funding toward new degree, or transfer students)
- Official Transcript from the term of attendance prior (every term, or if official transcript is unavailable, a direct e-mail from each instructor to Scholarship Program Coordinator with student’s grade every 16 weeks until completion of program)
- Copy of Marriage Certificate & proof of dependents (if applicable)
- Official Transcript from the term of attendance prior (every term, or if official transcript is unavailable, a direct e-mail from each instructor to Scholarship Program Coordinator with student’s grade every 16 weeks until completion of program)
- Acceptance Letter (for 1st time applicants, 1st term of funding toward new degree, or transfer students)
- Copy of Marriage Certificate & proof of dependents (if applicable)
- Acceptance Letter (for 1st time applicants, 1st term of funding toward new degree, or transfer students)
- Official Transcript from the term of attendance prior (every term...with dates, times, credit hours, professors, and locations—calendar versions not accepted)
- Acceptance Letter (for 1st time applicants, 1st term of funding toward new degree, or transfer students)
- Copy of Certificate/ Degree when completed
v. Graduate Level: Doctorate Degree

- Completed Education Assistance Request Forms: Students fill out the top, then give to school’s Financial Aid Office/Billing Office to fill out the middle, and ask that office to e-mail completed form directly to the Scholarship Program Coordinator.

- Completed Oneida Indian Nation Education Department Student Consent to Release Information Form

- Direct Deposit Form and Official Bank Letter/Unidad Check, if direct deposit is stipend or preferred

- Signed Scholarship Agreement Form (every term)

- Acceptance Letter (for 1st time applicants or transfer students)

- Complete Plan of Study (1st term of funding) Estimated course list for each term for entirety of program, completed with Academic Advisor. Student notifies Scholarship Program Coordinator of changes if/as needed each term.

- Letter from Academic Advisor (1st term) Letter written by student’s Academic Advisors that states the overall requirements/changes if/as needed each term.

- Enrollment Verification Forms on November 15th for the Fall term and on February 15th and May 15th for the Spring term, signed and mailed to school's Financial Aid Office/Billing Office (and midway through each term if other type of academic calendar is used).

- Copy of student’s FAFSA Student Aid Report (if applicable; some trade/vocational programs are not eligible for FAFSA. If program is eligible, student is required to apply. Only needs to be submitted once per academic year)

- Instructions on how to view/download SAR can be found here: https://studentaid.gov/help/view-sar

- Copy of Marriage Certificate & proof of dependents (if applicable)

- Copy of student or spouse's pay-stub (part-time students only, if applicable)

- Copy of Marriage Certificate & proof of dependents (if applicable)

- Copy of Certificate/Degree when completed.

F. Scholarship Program Eligibility

1. Scholarship recipients must be enrolled Members of the Oneida Indian Nation, which is located in New York. (every term)

2. Scholarship recipients must show proof of acceptance at a college or university or they will be considered a non-matriculated student.

3. The Nation will not fund online courses unless they are through an accredited college/university and the exams are taken on-site with a proctor. If more than half of the student’s courses are online, then student scholarship and stipend amounts may be reduced to half or part-time status. (every term)

4. Students younger than age 18 are entitled to take college accredited courses that are transferable to a degree program. Students who are not in high school must have a GED or equivalent, or be enrolled in an accredited college to obtain their GED. (and midway through each term if other type of academic calendar is used)

5. Students must designate a field of study, including expected graduation date. Undergraduate students must designate a field of study by their 3rd term of Scholarship Program funding.

6. Each scholarship recipient must maintain a term academic grade point average (GPA) of at least 2.01 or higher.

- If the GPA is 0.00 to 1.00, students will have to repay the total awarded scholarship and stipend amounts to them from the term. Students who are in high school must have a GED or equivalent, or be enrolled in an accredited college/university and the exams are taken on-site with a proctor. If more than half of the student’s courses are online, then student scholarship and stipend amounts may be reduced to half or part-time status. If the term GPA is 1.01 to 2.00, students will need to go on term one on their own and repay the amount they owe in full. If the term GPA is 2.01 or higher, students will need to go on term one on their own and repay the amount they owe in full. (if applicable)

- If student’s Term GPA falls within the repayment range (0.00 to 1.00), student must establish a repayment plan. Students must fill out and sign a Distribution Deduction Form provided to them by the Scholarship Program Coordinator directly. In case of unforeseen national or global emergency, online courses funding eligibility will be reviewed by Council and determined on a case by case basis.

7. If the term GPA is 0.00 to 1.00, student must establish a repayment plan. Students must fill out and sign a Distribution Deduction Form provided to them by the Scholarship Program Coordinator directly. In case of unforeseen national or global emergency, online courses funding eligibility will be reviewed by Council and determined on a case by case basis.

• Students must indicate the amount they would like deducted from their next distributions. The minimum amount that can be requested for deduction is $2,000.00 (unless the full repayment amount is lower than that, in which case the full amount must be indicated), and the maximum amount that can be requested to be deducted is $4,000.00.

- If students do not return the form by the requested deadline, students may face an additional 25% surcharge to their repayment amount. Please contact the Scholarship Program Coordinator for instructions if student would like to write a personal check for repayment.
11. Short-term seminars and workshops must be related to educational success or directly related to career advancement. Students are allowed to keep 20% of their scholarship and stipend amount. Students may need to fill out their school’s FERPA permission form and send an e-mail to the professor of each of their courses with the FERPA form attached, and request that their official letter grade from the course be sent to the Scholarship Coordinator in a direct e-mail.

12. If students withdraw from a term, they should contact and notify the institution’s Registrar’s Office immediately to follow formal withdrawal procedure. Students must also submit proof of attendance, which will include proof of registration and/or a class schedule, in addition to submitting two Enrollment Verification Forms/Letter provided by their school to the Scholarship Program Coordinator mid-way through each term of funding.

13. a.) Only one workshop/certificate per Member per year.
   b.) Only one business certificate per Member.
   c.) Only one degree per-degree-type per Member.

14. Part-time students must qualify for part-time awards by: a.) Proof of full-time employment, at least 30 hours/week; b.) Proof of spouse being employed full-time and Member with full-time status is 12 or more credits per semester and graduate full-time status is 9 or more credits per semester.

15. If a student attends full-time and receives credit for less than full-time, the professor must immediately update the student’s GPA the term prior to a full withdraw was a 2.01 or higher during that term without Nation funding, in addition to repaying in full. If the student’s GPA the term prior to a full withdraw was a 2.01 or higher, the student may not have to attend a term on own. If the student’s GPA the term prior to a full withdraw was a 2.0 or lower, the student may be ineligible for future funding, and may have the applicable funds deducted from their distribution with an added surcharge of 25%. The student may be ineligible for another award until the balance is repaid in full. If the student’s GPA the term prior to a full withdraw was a 2.01 or above, the student may not have to attend a term on own. If the student’s GPA the term prior to a full withdraw was a 2.0 or lower, the student may be ineligible for future funding, and may have the applicable funds deducted from their distribution with an added surcharge of 25%. The student may be ineligible for another award until the balance is repaid in full. If the student’s GPA the term prior to a full withdraw was a 2.01 or above, the student may not have to attend a term on own. If the student’s GPA the term prior to a full withdraw was a 2.0 or lower, the student may be ineligible for future funding, and may have the applicable funds deducted from their distribution with an added surcharge of 25%.

16. If a student attends full-time and receives credit for less than full-time, the professor must immediately update the student’s GPA the term prior to a full withdraw was a 2.0 or lower, the student may be ineligible for future funding, but will need to repay, in full, the difference of what is owed, and provide proof of employment.

17. All students must submit proof of attendance, which will include proof of registration and/or a class schedule, in addition to submitting two Enrollment Verification Forms per year, one in Fall and one in Spring.

18. The Nation accepts the accredited institution’s status of full-time or part-time. Full-time and part-time status will vary depending on institution, already used, and degree level. Generally, undergraduate full-time status is 12 or more credits per semester and graduate full-time status is 9 or more credits per semester. The student may test out of “Oneida Indian Nation” and tested in the Scholarship Program Coordinator at 5000 Skenondoa Way Oneida, NY 13421.

19. If students withdraw from a term, they should contact and notify the institution’s Registrar’s Office immediately to follow formal withdrawal procedure. Students must also submit proof of attendance, which will include proof of registration and/or a class schedule, in addition to submitting two Enrollment Verification Forms/Letter provided by their school to the Scholarship Program Coordinator mid-way through each term of funding.

20. If students attend in the summer, they must be considered full-time in order to receive applicable full scholarship and stipend amounts. Full-time graduate level students receive a summer stipend if they were enrolled in the previous Spring term and will be enrolled in the following Fall term. This stipend is half of the amount of total term stipend installment in applicable degree category, as indicated on their School's FERPA permission form, to the Scholarship Program Coordinator. If medical documentation is accepted, student may only need to repay half of the total amount that was awarded to the student for that term.

21. If students receive an “Incomplete” grade in a course, the scholarship recipient must request that their professor in that course send an official e-mail or official letter to the Scholarship Program Coordinator. Students must also submit proof of attendance, which will include proof of registration and/or a class schedule, in addition to submitting two Enrollment Verification Forms/Letter provided by their school to the Scholarship Program Coordinator. If medical documentation is accepted, student may only need to repay half of the total amount that was awarded to the student for that term.
All students must show that they are progressing in their degree in order to be funded and cannot go backwards in earning a degree type. Students will not receive funding for a lower-level degree type if they have already earned a higher-level degree that was funded by the Nation. Maximum terms/semesters/trimesters/quarters/courses (depending on institution’s academic system) are funded as follows:

*ONLY ONE DEGREE PER STUDENT PER LEVEL*

**H. Number of Terms Funded**

Students will be classified in one of 18 categories. They will receive their scholarship award and stipend award (if applicable) based on the program for which they are enrolled when requirements are met.

At the undergraduate and graduate level, the Nation accepts the institution’s status of full-time or part-time as classified by each institution’s Registrar’s Office. Full-time and part-time status will vary depending on institution and degree level. Generally speaking, undergraduate full-time status is 12 or more credits and graduate full-time status is 9 or more credits. Part-time course terms will be adjusted accordingly based on credit hours.

At the vocational/technical trade level, the Nation classifies students carrying 18+ clock hours per week to be full-time and vocational/technical trade students carrying 17 or less clock hours per week to be part-time. Oneida Indian Nation clock hour full-time/part-time classifications listed are based on federal financial assistance guidelines, credit-hour conversions in relation to program length/duration, and other institutional and Nation policy factors.

18 Student Classifications:

1. Matriculated Full-Time Vocational Students
2. Matriculated Full-Time Undergraduate Students
3. Matriculated Full-Time Graduate Students
4. Non-matriculated Full-Time Vocational Students
5. Non-matriculated Full-Time Undergraduate Students
6. Non-matriculated Full-Time Graduate Students
7. Matriculated Part-Time Vocational Students
8. Matriculated Part-Time Undergraduate Students
9. Matriculated Part-Time Graduate Students
10. Non-Matriculated Part-Time Vocational Students
11. Non-Matriculated Part-Time Undergraduate Students
12. Non-Matriculated Part-Time Graduate Students
13. High School Students Taking Exam Prep Courses
14. High School Students Taking Exams
15. High School Students Taking College Courses
16. Certificate Candidate Students
17. Short-term Seminar/workshop Students
18. Certificate, vocational, undergraduate, and graduate students taking exams

Please see charts on the following pages for each of the 18 student categories funding amounts.

*Any student attending an institution with a different academic year system and/or degree/certificate length than classified above (ex: sessions, or 11-month program duration, etc.), will have terms adjusted accordingly on a case-by-case basis.

**I. Classification**

<table>
<thead>
<tr>
<th>Degree</th>
<th>Full-time Semesters</th>
<th>Full-time Trimesters</th>
<th>Full-time Quarters</th>
<th>Approximate number of courses total, if part-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-year Degree/Certificate</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>10</td>
</tr>
<tr>
<td>2-year Vocational or Technical School Degree/Cert.</td>
<td>5</td>
<td>7</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Associate</td>
<td>3</td>
<td>7</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Bachelor’s</td>
<td>10</td>
<td>13</td>
<td>17</td>
<td>44</td>
</tr>
<tr>
<td>Bachelor’s <em>4-year degree graduated</em></td>
<td>5</td>
<td>7</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Master’s</td>
<td>5</td>
<td>7</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Ph.D</td>
<td>10</td>
<td>13</td>
<td>17</td>
<td>44</td>
</tr>
<tr>
<td>Professional Practice Non-Ph.D</td>
<td>10</td>
<td>13</td>
<td>17</td>
<td>44</td>
</tr>
<tr>
<td>Juris Doctor</td>
<td>7</td>
<td>10</td>
<td>13</td>
<td>28</td>
</tr>
<tr>
<td>Medical Practice</td>
<td>10</td>
<td>13</td>
<td>17</td>
<td><em>case-by-case basis</em></td>
</tr>
</tbody>
</table>
1. Matriculated Full-Time Students:

   a. Undergraduate & Graduate Level: Degree-seeking students enrolled at a regionally, nationally, or internationally accredited college or university, carrying the minimum number of credit hours required to be full-time status or more, as per official policy according to the institution’s Registrar’s Office classifications, will be considered full-time.

   b. Vocational Level: Degree/Certificate-seeking students enrolled at a regionally or nationally accredited business or technical school, carrying 18+ clock hours per week, as per official policy according to the Oneida Indian Nation clock-hour classifications based on federal financial assistance guidelines, or the minimum number of credit hours required to be full-time status or more at the institution, will be considered full-time.

2. Please note that the TOTAL/MAXIMUM yearly scholarship amount for which a student is eligible (based on need) remains the same. Scholarship awards are paid directly to the academic institution in one lump sum each term and divided out equally based on the yearly amount, according to academic term system. Award per semester is based on an institution that operates on a 2 semester schedule where 2 payments are sent per year. Award per trimester is based on an institution that operates on a 3 trimester schedule where 3 payments are sent per year. Award per quarter is based on an institution that operates on a 4 quarter system where 4 payments are sent per year. Scholarship and stipend amounts will be adjusted accordingly on a case-by-case basis for any student attending an academic system other than those specified above (e.g. sessions). Students are only eligible for yearly amount in total listed if grade requirements are met every term.

3. Stipends listed are the total amount a student is eligible to receive in one term. If applicable:
   - official copy of lease agreement or mortgage statement required. Copy of marriage license, domestic partnership certificate, or divorce decree required. Any dependents’ birth certificates, proof of custody, school records, child support order, doctor’s verification required.
   - Stipends greater than $2,000 in total are divided into 8 biweekly installments that are paid to the student throughout the term.
   - Stipends between $1,000 and $2,000 are divided into 2 installments paid to the student once at the beginning of the term and once at the end of the term.
   - Stipends that are less than $1,000 are sent as one single check for the term.

4. Minimum amount in this category begins at Married Students with 0 dependents and increases by $500 per dependent. "Single Parent Students" and "Married Students with 1 child" stipends are calculated by adding $500 to the base minimum of applicable academic system in that category. Any students in this category with more children, an additional $500 is added per each child (up to 4 children total) for the maximum amount.

5. Includes:

6. Includes:

7. Award amounts for Vocational/Trade/Certificate Programs for courses only scheduled for 2 to 9 weeks in total are determined within listed range. Any single day to one-week program that is less than 36 hours total, please refer to Section N: Other Funding Opportunities, page 23, and see Workshop/Certificate Student category.
1. Non-matriculated Full-Time Students:
   a. Undergraduate & Graduate Level: Non-degree-seeking students enrolled at a regionally, nationally, or internationally accredited college or university, carrying the minimum number of credit hours required to be full-time status or more, as per official policy according to the institution’s Registrar’s Office classifications, will be considered full-time.
   b. Vocational Level: Non-Degree/Non-certificate-seeking students enrolled at a regionally or nationally accredited business or technical school, carrying 18+ clock hours per week, as per official policy according to the Oneida Indian Nation clock-hour classifications based on federal financial assistance guidelines, or the minimum number of credit hours required to be full-time status or more at the institution, will be considered full-time.
   Please NOTE: only 2 full-time (or 4 part-time) non-matriculated terms within a 5-year period are funded.

2. Please note that the TOTAL/MAXIMUM yearly scholarship amount for which a student is eligible (based on need) remains the same. Scholarships awards are paid directly to the academic institution in one lump sum each term and divided out equally based on the yearly award amount, according to academic term system. Award per semester is based on an institutional academic system that operates on a 2 semester schedule where 2 payments are sent per year. Award per trimester is based on an institution that operates on a 3 term schedule where 3 payments are sent per year. Award per quarter is based on an institution that operates on a 4 term system where 4 payments are sent per year. Scholarship and stipend amounts will be divided according to the academic system terms other than those specified above. Students are only eligible for yearly amount in total listed if grade requirements are met every term.

3. Stipends listed are the total amount a student is eligible to receive in one term.
   • Stipends greater than $2,000 in total are divided into 8 biweekly installments that are paid to the student throughout the term. Stipends between $1,000 and $2,000 are divided into 2 installments paid to the student once at the beginning of the term and once at the end of the term. Stipends that are less than $1,000 are sent as one single check for the term.
   • 4 flat rate stipends within each degree category. Lease/dependents are not factored into stipend in this category due to non-matriculated status.

4. Includes:

5. Includes:

6. Award amounts for Vocational/Trade/Technical Certificate Programs for courses only scheduled for 2 to 9 weeks in total are determined within listed range.
1. Matriculated Part-Time Students:
   a. Undergraduate & Graduate Students:
      Degree-seeking students enrolled at a regionally, nationally, or internationally accredited college or university, carrying the number of credit hours required to qualify as part-time status, as per official policy according to the institution’s Registrar’s Office classifications, will be considered part-time. All undergraduate, Master’s, and Ph.D. students must also provide proof of work or other applicable documentation (See Section F: Eligibility #14, page 12) in addition to official schedules to qualify for part-time funding.

   b. Vocational Students:
      Certificate-seeking students enrolled at a regionally or non-regionally accredited trade or vocational school, carrying between 1-17 clock hours per week, as per official policy according to the Oneida Indian Nation clock hour classifications based on federal financial assistance guidelines, or the number of credit hours by the institution to qualify as part-time status will be considered part-time. All part-time vocational students must also provide proof of 30 hours of work per week or other applicable documentation (See Section F: Eligibility #14, page 12) in addition to official schedules to qualify for part-time funding.

2. Please note that the TOTAL/MAXIMUM yearly scholarship amount for which a student is eligible (based on need) remains the same. Scholarship awards are paid directly to the academic institution in one lump sum each term and divided out equally based on this yearly amount, according to academic term system. Award per semester is based on an institution that operates on a 2 semester schedule where 2 payments are sent per year. Award per trimester is based on an institution that operates on a 3 term schedule where 3 payments are sent per year. Award per quarter is based on an institution that operates on a 4 term system where 4 payments are sent per year. Scholarship and stipend amounts will be adjusted accordingly on a case-by-case basis for any student attending an institution operating on any academic system terms other than those specified above (e.g. sessions). Students are only eligible for yearly amount in total listed if grade requirements are met every term.

3. Stipends listed are the total amount a student is eligible to receive in one term.

   a. If applicable: official copy of lease agreement or mortgage statement required. Copy of marriage license, domestic partnership certificate, or divorce decree required. Any dependents’ birth certificates, proof of custody, school records, child support order, doctor’s verification required.

   b. Stipends greater than $2,000 in total are divided into 8 biweekly installments that are paid to the student throughout the term.

   c. Stipends between $1,000 and $2,000 are divided into 2 installments paid to the student once at the beginning of the term and once at the end of the term.

   d. Stipends that are less than $1,000 are sent as one single check for the term.

4. Minimum amount in this category begins at Married Students with 0 dependents and increases accordingly. “Single Parent Students” and “Married Students with 1 child” stipends are calculated by adding $500 to the base minimum of applicable academic system in that category. Any students in this category with more children, an additional $500 is added per each child (up to 4 children total) for the maximum amount.

5. Includes:

6. Includes:

7. Award amounts for Vocational/Trade/Technical Certificate Programs for courses only scheduled for 2 to 9 weeks in total are determined within listed range. Any single day to one-week program that is less than 36 hours total, please refer to Section N: Other Funding Opportunities, page 23, and see Workshop/Certificate Student category.
1. **Non-matriculated Part-Time Students:**
   a. **Undergraduate & Graduate Level:** Non-degree-seeking students enrolled at a regionally, nationally, or internationally accredited college or university, carrying the number of credit hours required to qualify as part-time status, as per official policy according to the institution’s Registrar’s Office classifications, will be considered part-time. All undergraduate, Master’s, and Ph.D. students must also provide proof of work or other applicable documentation (See Section F: Eligibility #14, page 11) in addition to official schedules in addition to official schedules to qualify for part-time funding.
   b. **Vocational Level:** Certificate-seeking students enrolled at a regionally, nationally, or internationally accredited business or technical school, carrying the number of credit hours as classified as part-time status as per official policy according to the Oneida Indian Nation clock hour classifications listed based on federal financial aid guidelines, will be considered part-time. All part-time vocational students must also provide proof of 30 hours of work per week in addition or other applicable documentation (See Section F: Eligibility #14, page 11) in addition to official schedules in addition to official schedules to qualify for part-time funding.

   **Please NOTE:** only 2 full-time (or 4 part-time) non-matriculated terms within a 5-year period are funded.

2. Please note that the **TOTAL/MAXIMUM yearly scholarship amount for which a student is eligible (based on need)** remains the same. Scholarship awards are paid directly to the academic institution in one lump sum each term and divided out equally based on this yearly amount, according to academic term system. Award per semester is based on an institutional academic system that operates on a 2 semester schedule where 2 payments are sent per year. Award per trimester is based on an institution that operates on a 3 term schedule where 3 payments are sent per year. Award per quarter is based on an institution that operates on a 4 term system where 4 payments are sent per year. Scholarship and stipend amounts will be adjusted accordingly on a case-by-case basis for any student attending an institution operating on any academic system other than those specified above (e.g. sessions). Students are only eligible for yearly amount in total listed if grade requirements are met every term.

3. **Stipends listed are the total amount a student is eligible to receive in one term.**  
   - Stipends greater than $2,000 in total are divided into 8 biweekly installments that are paid to the student throughout the term.  
   - Stipends between $1,000 and $2,000 are divided into 2 installments paid to the student once at the beginning of the term and once at the end of the term.  
   - Stipends that are less than $1,000 are sent as one single check for the term.

4. **Flat rate stipend within each degree category.** Lease/dependents are not factored into stipend in this category due to non-matriculated status.


7. **Award amounts for Vocational/Trade/Technical Certificate Programs for courses only scheduled for 2 to 9 weeks in total are determined within listed range.**
1. Official documentation including proof of registration and receipts for exam and/or course must be provided. Career improvement or professional development trainings require submittal of proof verifying course’s academic or career requirement/recommendation. Funding for any other category not listed above will be considered on a case-by-case basis with Council’s approval.

2. Terms listed may be adjusted on a case-by-case basis with official documentation of need provided for approval by Council.

3. Registration, location/address of courses, and student permanent address must be provided.

4. High School students should first check with their High School Guidance Counselor to verify eligibility criteria for fee waivers. Students who qualify for application fee waivers may be ineligible for Oneida Indian Nation Scholarship Program exam fee funding.

5. Exams are usually located at student’s High School. If exam is located elsewhere, please contact Scholarship Program Coordinator.

6. Cost of application fee and official receipt required. Students who qualify for application fee waivers may be ineligible for Oneida Indian Nation Scholarship Program application fee funding. High School students should check with their High School Guidance Counselor to verify fee waiver eligibility.

7. Certificate Students: Students enrolled in a program requiring at least 36 classroom hours, but not degree seeking. Courses may include continuing education credits or career improvement trainings. Only one certificate per student, per course.

8. Short-term Seminar/Workshop Students: Students enrolled in a class requiring less than 36 classroom hours, but not degree seeking.

---

### Description of Educational Opportunities

<table>
<thead>
<tr>
<th>Description</th>
<th>Terms</th>
<th>Expense Coverage and Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>High School SAT, ACT prep courses</td>
<td>1 course for each exam covered</td>
<td>Scholarship: Based on need, Max $350</td>
</tr>
<tr>
<td>College Credit Courses for High School Students</td>
<td>Maximum of 10 courses covered</td>
<td>Scholarship: Based on need, Max $500 per course</td>
</tr>
<tr>
<td>Educational Institution Application Fees</td>
<td></td>
<td>Scholarship: Based on need, Max $500</td>
</tr>
<tr>
<td>Educational Institution Tuition Deposit Reimbursement</td>
<td></td>
<td>Scholarship: Based on need, Max $500</td>
</tr>
<tr>
<td>Certificate: Continuing Education credits, career improvement trainings</td>
<td>1 per year</td>
<td>Scholarship: Based on need, Max $500</td>
</tr>
<tr>
<td>Other Exams Prep/Prep course for GRE, LSAT, USMLE, MCAT, or other mandated exams required by institution or for degree</td>
<td>1 course for each exam covered</td>
<td>Scholarship: Based on need, Max $350</td>
</tr>
<tr>
<td>Other Exams Prep/Prep course for Professional or Academic Development</td>
<td>Each exam covered once</td>
<td>Scholarship: Exam Fee Covered</td>
</tr>
<tr>
<td>Other Exams for Professional or Academic Development</td>
<td>Based on professional or academic requirement</td>
<td>Scholarship: Based on need, Max $1,000</td>
</tr>
</tbody>
</table>

### Educational Opportunity Details

- **High School Students**
  - SAT, ACT, and AP exams per academic subject covered
  - Scholarship: Exam fee covered
  - Cost: $500

- **College Credit Courses**
  - Maximum of 10 courses covered
  - Scholarship: Based on need, Max $500 per course

- **Educational Institution Application Fees**
  - Based on need, per degree level
  - Maximum: $500

- **Educational Institution Tuition Deposit Reimbursement**
  - Covered in full, but total amount of reimbursement is deducted from overall term scholarship award for the first term of attendance at educational institution.

- **Certificate: Continuing Education credits, career improvement trainings**
  - 1 per year
  - Scholarship: Based on need, Max $350

- **Short-term Seminar/Workshop**
  - 1 course for each exam covered
  - Scholarship: Based on need, Max $350

- **Other Exams Prep/Prep course for GRE, LSAT, USMLE, MCAT, or other mandated exams required by institution or for degree**
  - Each exam covered once
  - Scholarship: Exam Fee Covered

- **Other Exams for Professional or Academic Development**
  - Based on professional or academic requirement
  - Scholarship: Based on need, Max $1,000

---

### Educational Institution Application Fees Details

- **High School SAT, ACT prep courses**
  - Cost: $350

- **College Credit Courses for High School Students**
  - Maximum of 10 courses covered
  - Scholarship: Based on need, Max $500 per course

- **Educational Institution Application Fees**
  - Based on need, per degree level
  - Maximum: $500

- **Educational Institution Tuition Deposit Reimbursement**
  - Covered in full, but total amount of reimbursement is deducted from overall term scholarship award for the first term of attendance at educational institution.

- **Certificate: Continuing Education credits, career improvement trainings**
  - 1 per year
  - Scholarship: Based on need, Max $350

- **Short-term Seminar/Workshop**
  - 1 course for each exam covered
  - Scholarship: Based on need, Max $350

- **Other Exams Prep/Prep course for GRE, LSAT, USMLE, MCAT, or other mandated exams required by institution or for degree**
  - Each exam covered once
  - Scholarship: Exam Fee Covered

- **Other Exams for Professional or Academic Development**
  - Based on professional or academic requirement
  - Scholarship: Based on need, Max $1,000

---

### Additional Information

- **High School PSAT, SAT, ACT, AP, IB, Exam Fees**
  - 1 SAT exam, 1 ACT exam, and 1 AP/IB exam per academic subject covered
  - Scholarship: Exam fee covered
  - Cost: $500

- **Certificate Students**
  - Only one certificate per student, per year.
  - Cost: $500

- **Other Funding Opportunities**
  - High School students should check with their High School Guidance Counselor to verify eligibility criteria for fee waivers. Students who qualify for application fee waivers may be ineligible for Oneida Indian Nation Scholarship Program exam fee funding.

---

### Table of Educational Institutions

<table>
<thead>
<tr>
<th>Description</th>
<th>Terms</th>
<th>Expense Coverage and Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>High School SAT, ACT prep courses</td>
<td>1 course for each exam covered</td>
<td>Scholarship: Based on need, Max $350</td>
</tr>
<tr>
<td>College Credit Courses for High School Students</td>
<td>Maximum of 10 courses covered</td>
<td>Scholarship: Based on need, Max $500 per course</td>
</tr>
<tr>
<td>Educational Institution Application Fees</td>
<td>Based on need, per degree level</td>
<td>Maximum: $500</td>
</tr>
<tr>
<td>Educational Institution Tuition Deposit Reimbursement</td>
<td>Covered in full, but total amount of reimbursement is deducted from overall term scholarship award for the first term of attendance at educational institution.</td>
<td></td>
</tr>
<tr>
<td>Certificate: Continuing Education credits, career improvement trainings</td>
<td>1 per year</td>
<td>Scholarship: Based on need, Max $350</td>
</tr>
<tr>
<td>Short-term Seminar/Workshop</td>
<td>1 course for each exam covered</td>
<td>Scholarship: Based on need, Max $350</td>
</tr>
<tr>
<td>Other Exams Prep/Prep course for GRE, LSAT, USMLE, MCAT, or other mandated exams required by institution or for degree</td>
<td>Each exam covered once</td>
<td>Scholarship: Exam Fee Covered</td>
</tr>
<tr>
<td>Other Exams for Professional or Academic Development</td>
<td>Based on professional or academic requirement</td>
<td>Scholarship: Based on need, Max $1,000</td>
</tr>
</tbody>
</table>
1. Enrolled Members must submit official transcripts or provide a copy of official school report cards to the Scholarship Program Coordinator. Nation Member vocational, undergraduate, and graduate students registered for the Scholarship Program are eligible for incentive awards as long as the student is not pursuing a duplicate degree. Nation Member students attending school on their own without Scholarship Program funding due to personal choice, GPA from previous semester, or exceeding maximum terms funded are eligible for incentive awards. Nation Member students in Scholarship Program repayment are still eligible for incentive awards.

2. Dean’s List and President’s List as determined by student’s institution of attendance. TERM GPA must align with institution’s Dean’s List qualifications as indicated on website or by institution’s Registrar’s Office. Dean’s List is usually an overall term GPA of 3.50+, but each institution has different qualifications. If an institution has an alternate grading system or if a student opts for an alternative grading system resulting in other grades than the typical A-F scale, student must sign a FERPA Form to release academic records, and send the FERPA Form to the professor of each applicable course requesting that the official letter grade of A-F earned in the course(s) be e-mailed directly to the Scholarship Program Coordinator.

3. Amounts of incentive award amounts offered per year are equal overall, but are calculated and allocated in even amounts per academic term system as designated by institution of attendance. Amounts are adjusted and dispersed equally based on institutional academic systems. Amounts for any institutional academic system not listed will be adjusted accordingly. Undergraduate and graduate incentive award amounts bolded are based off a standard 2-semester academic system. High school, middle school, and elementary school incentive amounts bolded are based off a standard 4-quarter academic system. Trimester and other term academic systems at the elementary, middle, high school, vocational, undergraduate, and graduate levels will be adjusted accordingly.

4. Doctoral students registered in courses in which A-F grades are not earned on Official Transcript or registered in research-based courses only are ineligible for incentive awards. Doctoral students registered in credit-bearing courses in which A-F grades are earned on Official Transcript and/or in which institution designates term Dean’s List distinctions, may be eligible for full-time incentive awards listed. Institutionally classified full-time Doctoral students in credit-bearing courses in which A-F grades are earned only in some courses and not others, are ineligible for the full-time incentive awards listed, and should instead refer to Chart P: Part-Time Incentive Awards, as students may be eligible for part-time incentive award amounts for the courses in which A-F grades are earned only.

5. High Honor Roll and Honor Roll status are determined in accordance with the qualifications of the high school the student is attending. High School students taking college courses are only eligible for the part-time, undergraduate incentive awards on Chart P if these college courses are not already included in or counted toward the student’s high school report card overall term GPA and are only documented separately through an official transcript from the college/university.

### O. Incentive Awards for Full-Time K-12, Vocational, Undergraduate, and Graduate Students

<table>
<thead>
<tr>
<th>Level</th>
<th>Distinction</th>
<th>Incentive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graduate</td>
<td>Doctorate</td>
<td>President’s Dean’s List</td>
</tr>
<tr>
<td></td>
<td>Professional Practice</td>
<td>$20,000/semester</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td></td>
<td>Medical Practice</td>
<td>$10,000/semester</td>
</tr>
<tr>
<td></td>
<td>Other Non-PHD</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td>Research</td>
<td>Ph.D.</td>
<td>President’s Dean’s List</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td></td>
<td>Medical Practice</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td>Master’s</td>
<td>All</td>
<td>President’s Dean’s List</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/semester</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td>Undergraduate</td>
<td>Bachelor’s</td>
<td>President’s Dean’s List</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/semester</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td>Associate</td>
<td>Certificate</td>
<td>4+ hours per week</td>
</tr>
<tr>
<td>Vocational</td>
<td>Associate</td>
<td>B+ or higher</td>
</tr>
<tr>
<td>Term Credit</td>
<td>18 hours per week</td>
<td>C+ or higher</td>
</tr>
</tbody>
</table>

High School Grades 7-12

- **High Honor Roll**: $125/semester, $25/quarter, $5/term for 4 terms
- **Honor Roll**: $25/semester, $5/quarter, $1/term for 4 terms

Elementary Grades 4-6

- **Overall Average of “B or better”**: $5 /term for 4 terms

| Attendance | 0 absences | $30 gift card/semester |
|        | 1 absence | $25 gift card/quarter |
|        | 2 absences | $15 gift card for 4 terms |
|        | 3 absences | $10 gift card/quarter |
|        | 4 absences | $5 gift card for 4 terms |

Grades K-3

- **Attendance only**

  | 0 absences | $30 gift card/semester |
|        | 1 absence | $25 gift card/quarter |
|        | 2 absences | $15 gift card for 4 terms |
|        | 3 absences | $10 gift card/quarter |
|        | 4 absences | $5 gift card for 4 terms |
|        | 5 absences | $0 gift card |

### Table 1

<table>
<thead>
<tr>
<th>Level</th>
<th>Distinction</th>
<th>Incentive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graduate</td>
<td>Doctorate</td>
<td>President’s Dean’s List</td>
</tr>
<tr>
<td></td>
<td>Professional Practice</td>
<td>$20,000/semester</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td></td>
<td>Medical Practice</td>
<td>$10,000/semester</td>
</tr>
<tr>
<td></td>
<td>Other Non-PHD</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td>Research</td>
<td>Ph.D.</td>
<td>President’s Dean’s List</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td></td>
<td>Medical Practice</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td>Master’s</td>
<td>All</td>
<td>President’s Dean’s List</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/semester</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td>Undergraduate</td>
<td>Bachelor’s</td>
<td>President’s Dean’s List</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/semester</td>
</tr>
<tr>
<td></td>
<td>President’s Dean’s List</td>
<td>$1,000/quarter</td>
</tr>
<tr>
<td>Associate</td>
<td>Certificate</td>
<td>4+ hours per week</td>
</tr>
<tr>
<td>Vocational</td>
<td>Associate</td>
<td>B+ or higher</td>
</tr>
<tr>
<td>Term Credit</td>
<td>18 hours per week</td>
<td>C+ or higher</td>
</tr>
</tbody>
</table>

High School Grades 7-12

- **High Honor Roll**: $125/semester, $25/quarter, $5/term for 4 terms
- **Honor Roll**: $25/semester, $5/quarter, $1/term for 4 terms

Elementary Grades 4-6

- **Overall Average of “B or better”**: $5 /term for 4 terms

| Attendance | 0 absences | $30 gift card/semester |
|        | 1 absence | $25 gift card/quarter |
|        | 2 absences | $15 gift card for 4 terms |
|        | 3 absences | $10 gift card/quarter |
|        | 4 absences | $5 gift card for 4 terms |

Grades K-3

- **Attendance only**

  | 0 absences | $30 gift card/semester |
|        | 1 absence | $25 gift card/quarter |
|        | 2 absences | $15 gift card for 4 terms |
|        | 3 absences | $10 gift card/quarter |
|        | 4 absences | $5 gift card for 4 terms |

2. Dean’s List and President’s List as determined by student’s institution of attendance. TERM GPA must align with institution’s Dean’s List qualifications as indicated on website or by institution’s Registrar’s Office. Dean’s List is usually an overall term GPA of 3.50+, but each institution has different qualifications. If an institution has an alternate grading system or if a student opts for an alternative grading system resulting in other grades than the typical A-F scale, student must sign a FERPA Form to release academic records, and send the FERPA Form to the professor of each applicable course requesting that the official letter grade of A-F earned in the course(s) be e-mailed directly to the Scholarship Program Coordinator.

3. Amounts of incentive award amounts offered per year are equal overall, but are calculated and allocated in even amounts per academic term system as designated by institution of attendance. Amounts are adjusted and dispersed equally based on institutional academic systems. Amounts for any institutional academic system not listed will be adjusted accordingly. Undergraduate and graduate incentive award amounts bolded are based off a standard 2-semester academic system. High school, middle school, and elementary school incentive amounts bolded are based off a standard 4-quarter academic system. Trimester and other term academic systems at the elementary, middle, high school, vocational, undergraduate, and graduate levels will be adjusted accordingly.

4. Doctoral students registered in courses in which A-F grades are not earned on Official Transcript or registered in research-based courses only are ineligible for incentive awards. Doctoral students registered in credit-bearing courses in which A-F grades are earned on Official Transcript and/or in which institution designates term Dean’s List distinctions, may be eligible for full-time incentive awards listed. Institutionally classified full-time Doctoral students in credit-bearing courses in which A-F grades are earned only in some courses and not others, are ineligible for the full-time incentive awards listed, and should instead refer to Chart P: Part-Time Incentive Awards, as students may be eligible for part-time incentive award amounts for the courses in which A-F grades are earned only.

5. High Honor Roll and Honor Roll status are determined in accordance with the qualifications of the high school the student is attending. High School students taking college courses are only eligible for the part-time, undergraduate incentive awards on Chart P if these college courses are not already included in or counted toward the student’s high school report card overall term GPA and are only documented separately through an official transcript from the college/university.
1. Enrolled Members must submit official transcripts or provide a copy of official school report cards to the Scholarship Program Coordinator. Nation Member vocational, undergraduate, and graduate students enrolled in the Scholarship Program are eligible for incentive awards as long as the student is not pursuing a duplicate degree. Nation Member students attending school on their own without Scholarship Program funding due to personal choice, GPA from previous semester, or exceeding maximum terms funded are eligible for incentive awards. Nation Member students in Scholarship Program repayment are still eligible for incentive awards.

2. Please note that the 3-credit hour per course distinction listed may vary depending on the institutional credit hour system designations and academic requirements. Generally, one academic course is an average of 3 institutional credit hours. Equal adjustments to award amounts may be made for varying institutional credit hour systems in which an A-F grade is earned. If an institution has an alternate grading system or if a student opts for an alternative grading system resulting in other grades than the typical A-F scale, student must sign a FERPA Form to release academic records, and send the FERPA Form to the professor of each applicable course requesting that the official letter grade of A-F earned in the course(s) be e-mailed directly to the Scholarship Program Coordinator.

3. Incentive award amounts offered per year are equal within each category. Amounts per term vary as each institution has a different academic term system. Award amounts per term are calculated based off of the same yearly amount and allocated evenly in alignment with applicable institutional academic term system. Amounts for any institutional academic system not listed may be adjusted accordingly. Undergraduate and graduate incentive award amounts listed are based off a standard 2-semester academic system. High school, middle school, and elementary school incentive amounts listed are based off a standard 4-quarter academic system. Trimester and other term academic systems at the elementary, middle, high school, vocational, undergraduate, and graduate levels will be adjusted accordingly.

4. Please note that credit-hours and award amounts listed in the chart are only applicable to courses in which an A-F grade is earned on an official transcript. Doctoral students registered in credit-bearing courses in which A-F grades are earned on official transcript may be eligible for part-time incentive awards. Doctoral students registered for courses in which A-F grades are not earned or applicable on official transcript, or registered for solely research-based courses, are ineligible for incentive awards.

5. High Honor Roll and Honor Roll status are determined in accordance with the qualifications of the high school the student is attending. High School students taking college courses are only eligible for the part-time, undergraduate incentive awards listed on chart above. If those college courses are not already included in or counted toward the student’s high school report card overall term GPA, and are instead only documented separately through an Official Transcript from the college/university.
1. How do I get a copy of the required Scholarship Program Forms?
   - Forms are accessible on the Nation Member Website/Nation Member Phone App.
   - Contact the Scholarship Program Coordinator to have them e-mailed or mailed to you.

2. What is the link to the Scholarship Program Website?
   - https://www.oneidaindiannation.com/scholarship-program

3. How do I download the Nation Member Phone App?
   - Contact Scholarship Program Coordinator or Member Outreach and Advocacy Coordinator (refer to “Helpful Contacts List” see FAQ #6) for instructions.

4. Can I send pictures of the required documents via e-mail?
   - PDF documents are highly preferred. In order to do this, copy and paste a picture/screenshot into Word. Make sure the picture is straight, cropped, and that there is nothing in the background. Also ensure that the picture is in good lighting.
   - To crop or adjust lighting/picture color in Word, click the pasted picture, go to Format > Crop, then Format > Corrections and/or Color, and adjust as needed.
   - To save as a PDF, go to File > Save As > Change File Name. Save with desired file name, then Click the drop down arrow where it says “Save as Type” and choose “PDF” > Click Save.

5. How can I find the contact information for other offices and agencies?
   - Please refer to the “Helpful Contacts List” location on the Nation Member Website and App.
   - Contact the Scholarship Program Coordinator to have it e-mailed to you.

6. Who do I contact if I have questions about my taxes and tax exemption statuses for FAFSA?
   - Please contact the Oneida Indian Nation Director of Treasury/Member Financial Services or the Oneida Indian Nation Member Financial Services Administrator. Please refer to “Helpful Contacts List” located on https://www.oneidaindiannation.com/scholarship-program-forms-and-applications/ for their contact information.

R. FAQ’s about Scholarship Program

1. How do I get a copy of the required Scholarship Program Forms?
   - Forms are accessible on the Nation Member Website/Nation Member Phone App.
   - Contact the Scholarship Program Coordinator to have them e-mailed or mailed to you.

2. What is the link to the Scholarship Program Website?
   - https://www.oneidaindiannation.com/scholarship-program

3. How do I download the Nation Member Phone App?
   - Contact Scholarship Program Coordinator or Member Outreach and Advocacy Coordinator (refer to “Helpful Contacts List” see FAQ #6) for instructions.

4. Can I send pictures of the required documents via e-mail?
   - PDF documents are highly preferred. In order to do this, copy and paste a picture/screenshot into Word. Make sure the picture is straight, cropped, and that there is nothing in the background. Also ensure that the picture is in good lighting.
   - To crop or adjust lighting/picture color in Word, click the pasted picture, go to Format > Crop, then Format > Corrections and/or Color, and adjust as needed.
   - To save as a PDF, go to File > Save As > Change File Name. Save with desired file name, then Click the drop down arrow where it says “Save as Type” and choose “PDF” > Click Save.

5. How can I find the contact information for other offices and agencies?
   - Please refer to the “Helpful Contacts List” location on the Nation Member Website and App.
   - Contact the Scholarship Program Coordinator to have it e-mailed to you.

6. Who do I contact if I have questions about my taxes and tax exemption statuses for FAFSA?
   - Please contact the Oneida Indian Nation Director of Treasury/Member Financial Services or the Oneida Indian Nation Member Financial Services Administrator. Please refer to “Helpful Contacts List” located on https://www.oneidaindiannation.com/scholarship-program-forms-and-applications/ for their contact information.

7. How do I apply for Federal Financial Aid?
   - Online at https://studentaid.ed.gov/sa/fafsa
   - Application takes an average of 5-7 days to fully process.

8. How do I obtain a copy of my FAFSA Student Aid Report?
   - Student Aid Reports are only accessible after FAFSA has officially processed.
   - Instructions on how to obtain SAR low https://studentaid.gov/sa/applicants-for-student-aid-and-fafsa-application#step=ost-1#10
copying-sar-form#statutory-statement
   - Click “Print” to dropbox box where printer name is listed, “Select “Save as PDF” “Name to computer as PDF to submit to Scholarship Program Coordinator.

---

Q. Incentive Awards for Diplomas, Degrees, and Certificates

<table>
<thead>
<tr>
<th>Degree/Certification</th>
<th>Award</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doctorate: Professional Practice</td>
<td>$12,000</td>
</tr>
<tr>
<td>Doctorate: Research Ph.D.</td>
<td>$10,000</td>
</tr>
<tr>
<td>Master’s Degree</td>
<td>$5,000</td>
</tr>
<tr>
<td>Graduate Certificate and Advanced Studies Certificates</td>
<td>$250</td>
</tr>
<tr>
<td>Bachelor’s Degree</td>
<td>$4,000</td>
</tr>
<tr>
<td>Undergraduate Certificate</td>
<td>$500</td>
</tr>
<tr>
<td>Associate Degree</td>
<td>$1,000</td>
</tr>
<tr>
<td>High School Diploma</td>
<td>$1,000</td>
</tr>
<tr>
<td>General Equivalency Diploma</td>
<td>$500</td>
</tr>
<tr>
<td>$1,000 – 500 hours Vocational Certificate</td>
<td>$500</td>
</tr>
<tr>
<td>$501 – 999 hours Vocational Certificate</td>
<td>$250</td>
</tr>
<tr>
<td>100–500 hours Vocational Certificate</td>
<td>$100</td>
</tr>
<tr>
<td>Less than 100 hours Vocational Certificate or Other Certificate Type</td>
<td>$50</td>
</tr>
</tbody>
</table>

* Students are eligible for only one incentive award per degree, per member. No duplicate degree incentive awards. Only one certificate allowed per year, per member. Official copy of degree or certificate must be submitted. 

---

**Note:** All information and requirements are subject to change without notice. Please visit the official FAFSA website for the most current information.
12. What do I do if I have an address change?

- Students must fill out their school’s FERPA Request Form and send Scholarship Coordinator with corresponding contact information to the FERPA form. Form can usually be found by searching: “[name of institution] + FERPA Release Form.” Students must indicate on form that Scholarship Coordinator is granted access to student Financial Aid information and billing. Completed and signed FERPA form should be sent to the student’s Financial Aid Office with EAR Form (top portion completed), and then the Financial Aid Office can complete the middle section of the EAR Form and send to Scholarship Coordinator.

10. What do I do if my scholarship is arriving after my payment due date?

- Ask the Scholarship Program Coordinator to write and send a Letter of Intent to Pay to your school’s Financial Aid Office.

11. How do I verify that my scholarship payment was received?

- Students are notified individually via e-mail by the Scholarship Program Coordinator when the term scholarship check is mailed. Students must provide an estimated invoice for an advance payment. This amount will later be deducted from the overall amount awarded for that same scholarship term. Scholarship Coordinator with corresponding contact information to the FERPA form is received at your school’s Business Office.

13. What do I do if I don’t receive a stipend check?

- If you opted to receive physical stipend checks via mail and have not received one after 12 days of the mailing date, notify the Scholarship Program Coordinator. The lost check can be cancelled and a replacement check can be issued. Checks cannot be reissued up to 30 days after the mailing date. If you have not received your payment within 30 days, contact your school’s Business Office.

14. Can I be reimbursed or given an advanced application supplement?

- Yes. Students must provide an estimated invoice for an advance and an official receipt after fee is paid, or an official receipt after fee is paid for a reimbursement. It is considered an early partial payment. This amount will later be deducted from the overall amount awarded for that same scholarship term. Scholarship Coordinator with corresponding contact information to the FERPA form is received at your school’s Business Office.

15. What if I am receiving an Excelsior scholarship or another scholarship?

- If you opted to receive physical stipend checks via mail and have not received one after 12 days of the mailing date, notify the Scholarship Program Coordinator. The lost check can be cancelled and a replacement check can be issued. Checks cannot be reissued up to 30 days after the mailing date. If you have not received your payment within 30 days, contact your school’s Business Office.

16. Are remedial courses funded?

- Yes. Students must provide an estimated invoice for an advance payment. This amount will later be deducted from the overall amount awarded for that same scholarship term. Scholarship Coordinator with corresponding contact information to the FERPA form is received at your school’s Business Office.

20. What if I fail one course?

- Student should notify Scholarship Program Coordinator. The student is responsible for repaying the difference in scholarship amount and any additional requirements may need to be fulfilled. If the student does not notify the Scholarship Program Coordinator, it will count toward their cumulative GPA until 12 days after the scholarship check is mailed/penalties. The student must submit an official receipt of payment otherwise the school will not receive one after 12 days of the mailing date, notify the Scholarship Program Coordinator. The lost check can be cancelled and a replacement check can be issued. Checks cannot be reissued up to 30 days after the mailing date. If you have not received your payment within 30 days, contact your school’s Business Office.

21. What if I receive a P/Fail, No-Credit/No-Pass or another alternate grade according to my school’s grading system?

- If an institution has an alternate grading system or a student opts for an alternate grading system resulting in grade other than the typical A-F scale, the student must sign a FERPA Form to release academic records to the Scholarship Program Coordinator, and send the FERPA Form to the professor of each course in the term scholarship check is mailed. The professor(s) email the Scholarship Program Coordinator. Please note that while institutions may not change the alternate grading system, the Oneida Indian Nation Scholarship Program uses the corresponding A-F scale letter grade system.

22. What happens if I drop to part-time status?

- Student should inform the Scholarship Program Coordinator as soon as possible and send a copy of the new official schedule and enrollment verification. Scholarship Coordinator is subject to financial aid, remittance, and any additional requirements may need to be fulfilled. If the student does not notify the Scholarship Program Coordinator, it will count toward their cumulative GPA until 12 days after the scholarship check is mailed/penalties. The student must submit an official receipt of payment otherwise the school will not receive one after 12 days of the mailing date, notify the Scholarship Program Coordinator. The lost check can be cancelled and a replacement check can be issued. Checks cannot be reissued up to 30 days after the mailing date. If you have not received your payment within 30 days, contact your school’s Business Office.

24. What happens if I receive an Incomplete?

- Student should inform Scholarship Program Coordinator. The student is responsible for repaying the difference in scholarship amount and any additional requirements may need to be fulfilled. If the student does not notify the Scholarship Program Coordinator, it will count toward their cumulative GPA until 12 days after the scholarship check is mailed/penalties. The student must submit an official receipt of payment otherwise the school will not receive one after 12 days of the mailing date, notify the Scholarship Program Coordinator. The lost check can be cancelled and a replacement check can be issued. Checks cannot be reissued up to 30 days after the mailing date. If you have not received your payment within 30 days, contact your school’s Business Office.

25. What happens if I withdraw?

- Please refer to Chart C. Other Scholarship Program Eligibility, Provisions #1 and #2 on page 12.

24. What happens if I receive an Incomplete?

- Student should notify Scholarship Program Coordinator. The student is responsible for repaying the difference in scholarship amount and any additional requirements may need to be fulfilled. If the student does not notify the Scholarship Program Coordinator, it will count toward their cumulative GPA until 12 days after the scholarship check is mailed/penalties. The student must submit an official receipt of payment otherwise the school will not receive one after 12 days of the mailing date, notify the Scholarship Program Coordinator. The lost check can be cancelled and a replacement check can be issued. Checks cannot be reissued up to 30 days after the mailing date. If you have not received your payment within 30 days, contact your school’s Business Office.
C. Methods of repayment

■ If the Term GPA is a 2.01 or higher and the student remained at full-time status, the student does not have to repay, but is required to attend a term on own, in order to receive scholarship funding for future term.

■ If the student provides proof of employment near the date of the status change, they may not have to repay.

■ Check official Term GPA.

II. Are the other scholarships I receive factored into determining scholarship need?

■ No. Scholarship allocations are based on a combination of requirements and factors. Please contact Scholarship Program Coordinator and Member Benefits Office a copy of their FAFSA, which has been evaluated and meets or exceeds established quality standards and is achieving its own goals.

R. FAQ’s about Scholarship Program

25. How do I know if I have to repay?

Check official Term GPA.

■ If the Term GPA is between 0.00-1.00, the student must repay the award from that term in full AND attend a term on own, in order to receive scholarship funding for future terms.

■ If the Term GPA is a 1.01-2.0, the student does not have to repay, but is required to attend a term on own, in order to receive scholarship funding for future term.

■ If the student drops from full-time to part-time status, and does not provide proof of employment near the date of the status change, they will have to repay in full. If the student provides proof of employment near the date of the status change, they may not have to repay.

■ The Scholarship Program Coordinator will send repayment notice and repayment instructions to student. Repayments must be received in full in order for student to be eligible for future scholarship awards. Other circumstances are reviewed on a case-by-case basis.

27. What if I have reached my maximum terms of funding and need to apply for more funding?

■ Student must notify the Scholarship Program Coordinator. The student must then complete and submit an Additional Term of Funding Request Form. The form is available on the Scholarship Program Website/Member App and Scholarship Program Documents. Student must submit completed form and any relevant/corresponding documentation (degree audit/degree works, letter plan from academic advisor, remaining coursework by term schedule, relevant medical or emergency documentation, etc.).

■ Refer to “Other Scholarship Resources” List on page 36 in this booklet or on the Scholarship Program Website/Member App.

Contact Scholarship Program Coordinator for any additional resources.

28. What other scholarships can I apply for?

■ The Education Department is not associated with Member quarterly distributions. Other circumstances are reviewed on a case-by-case basis.

■ Part-time students must also be sure to send the Scholarship Program Coordinator and Member Benefits Office a copy of their FAFSA documentation, which has been evaluated and meets or exceeds established quality standards and is achieving its own goals.

■ Separately, Federal Financial Aid (FAFSA) classifies undergraduate students as dependents until age 24, unless the student is (a) married, (b) a U.S. veteran, (c) in active duty military service other than training purposes, (d) an emancipated minor, (e) an unaccompanied youth, (f) a dependent of the food stamp recipient, (g) a homeless youth or youth-supporting adult at risk for homelessness, (h) someone who has been in foster care, (i) someone who has been in the foster care system for any period of time after age 15, (j) someone who provides more than half of the financial support for a child who lives with student, in which case, the student may be classified as independent if younger than 24 according to FAFSA guidelines. For more specific information, go to: https://studentaid.gov/apply-for-aid/fafsa/dependency.

■ Embraced Onida Indian Nation Members: Individuals in good standing who can prove their membership by certification by the Onida Indian Nation Clerk and have an enrollment number.

■ For more information, go to: https://studentaid.gov/apply-for-aid/fafsa.

II. Time and Part-Time

■ Full-time students must also be sure to send the Scholarship Program Coordinator and Member Benefits Officer a copy of their FAFSA. While students may be on the approved student list, it is the responsibility of the student to attend a term on own, in order to receive scholarship funding for future terms. If the student provides proof of employment near the date of the status change, they will have to repay in full. If the student provides proof of employment near the date of the status change, they may not have to repay.

■ The Scholarship Program Coordinator will send repayment notice and repayment instructions to student. Repayments must be received in full in order for student to be eligible for future scholarship awards. Other circumstances are reviewed on a case-by-case basis.

■ Embodied Onida Indian Nation Members: Individuals in good standing who can prove their membership by certification by the Onida Indian Nation Clerk and have an enrollment number.
S. Terms and Definitions

Financial Aid Office: Office at an academic institution where students can receive help with financial aid information, student loans, grants, scholarships, etc. Oneida Indian Nation Education Assistance Request Forms must be completed by this Office and sent directly to the Scholarship Program Coordinator.

Full-Time student: a student who is enrolled in the required number of credit hours to be considered full-time as per the academic institution in attendance Registrar’s Office requirements. Usually, undergraduate part-time status is 12 or more credits. Graduate level part-time status is usually 9 or more credits. However, credit hours and part-time status vary depending on institutional. Vocational students attending 18 or more credit hours per week are considered full-time by Oneida Indian Nation.

GPA: Grade point average. Oneida Indian Nation uses student’s TERM GPA (not Cumulative GPA) in order to determine funding eligibility for future terms.

Graduate Student: Student who has already earned a Bachelor’s Degree and is enrolled in coursework toward a Master’s or Doctorate Degree.

Married: Student who is legally married; marriage is recognized by the state. Official documentation required.

Matriculated: Student who has applied for and been accepted into a degree-granting or certificate-granting program.

MBO: Oneida Indian Nation Member Benefits Office.

Non-matriculated: Student is registered for classes as non-degree seeking or non-certificate seeking.

Part-time student: a student who is enrolled in the required number of credit hours to be considered part-time as per the academic institution in attendance Registrar’s Office requirements. Usually, undergraduate part-time status is 11 credits or less. Graduate level part-time status is usually 8 credits or less. However, credit hours and part-time status vary depending on institutional. Please check your institution’s website, or with the institution’s Registrar’s Office, in order to verify credit hours and enrollment status. Vocational students are considered part-time by Oneida Indian Nation if attending between 1-17 credit hours per week.

Post-secondary: Education after high school.

Registrar’s Office: Office at an academic institution where students can get their enrollment, academic, registration, and course records.

Subsidized Loan: Federal student loan offered to some vocational and undergraduate students. Interest on loan does not accrue while you are enrolled in school. Financial need required.

Unsubsidized Loan: Federal student loan offered to undergraduate and graduate students. Interest on loan accrues while you are enrolled in school. Financial need not required.

Vocational Student: Post-secondary trade or technical school student.

Undergraduate Student: Post-secondary student pursuing an Associate or Bachelor’s degree.

T. Other Scholarship Organizations & Resources

You can find a list of other scholarship resources for Native students on the Scholarship Program website or Member App. You can also e-mail the Scholarship Coordinator to ask for a list.

Organizations that offer scholarships to Native and Indigenous Students:

American Indian College Fund
collegefund.org/students/scholarships
• FOR students at any level of education: vocational, undergraduate, and graduate
• FOR enrolled members and descendants
• HIGHLY ENCOURAGED: Create login and subscribe to their e-mail list!

American Indian Education Fund
www.nativepartnership.org/site/PageServer?page_name=aief_services_scholarships
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

American Indian Graduate Center
www.aigcs.org/scholarships-fellowships
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

American Indian Science and Engineering Society
www.aises.org/students/scholarships
First, register as a member for free, then create an account for General Application Profile, and it will give you access to a portal through Indigenous Education, Inc. that will automatically list/match for you all scholarships for which you are eligible to apply. From there, you can apply to each scholarship.
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

Bill & Melinda Gates Foundation
www.thegatesscholarship.org/scholarship
• FOR undergraduate students, high school seniors who are eligible for Pell grant and in top 10% of class
• FOR enrolled members only

Bureau of Indian Education Higher Education Grant
www.oneidaindiannation.com/scholarship-program-forms-and-applications
• FOR full-time vocational and undergraduate students only
• FOR enrolled members only

Catching the Dream Scholarship
www.catchingthedream.org
• FOR undergraduate and graduate students
• FOR enrolled members only

You can find a list of other scholarship resources for Native students on the Scholarship Program website or Member App. You can also e-mail the Scholarship Coordinator to ask for a list.

Organizations that offer scholarships to Native and Indigenous Students:

American Indian College Fund
collegefund.org/students/scholarships
• FOR students at any level of education: vocational, undergraduate, and graduate
• FOR enrolled members and descendants
• HIGHLY ENCOURAGED: Create login and subscribe to their e-mail list!

American Indian Education Fund
www.nativepartnership.org/site/PageServer?page_name=aief_services_scholarships
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

American Indian Graduate Center
www.aigcs.org/scholarships-fellowships
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

American Indian Science and Engineering Society
www.aises.org/students/scholarships
First, register as a member for free, then create an account for General Application Profile, and it will give you access to a portal through Indigenous Education, Inc. that will automatically list/match for you all scholarships for which you are eligible to apply. From there, you can apply to each scholarship.
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

Bill & Melinda Gates Foundation
www.thegatesscholarship.org/scholarship
• FOR undergraduate students, high school seniors who are eligible for Pell grant and in top 10% of class
• FOR enrolled members only

Bureau of Indian Education Higher Education Grant
www.oneidaindiannation.com/scholarship-program-forms-and-applications
• FOR full-time vocational and undergraduate students only
• FOR enrolled members only

Catching the Dream Scholarship
www.catchingthedream.org
• FOR undergraduate and graduate students
• FOR enrolled members only
T. Other Scholarship Organizations & Resources

Cobell Scholarship
www.cobellscholar.org
• FOR vocational, undergraduate, and graduate students
• FOR enrolled members only

Daughters of the American Revolution Scholarship
www.dar.org/national-society/scholarships
www.dar.org/national-society/scholarships/american-indian
• FOR undergraduate students
• FOR enrolled members and descendants

Indigenous Education Inc.
www.i-e-i.org/scholarship-resources
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

International Order of the King’s Daughters & Sons, North American Indian Department
www.iokds.org/scholarships/native-american-scholarship-program
• FOR vocational and undergraduate students
• FOR enrolled members only

Intertribal Timber Council
www.itcnet.org/about_us/scholarships.html
• FOR undergraduate and graduate students studying Natural Resources and Sciences
• FOR enrolled members

National Association of Social Workers Foundation
www.naswfoundation.org/Our-Work/Scholarships-Fellowships
-Awards/Scholarships
• FOR graduate students studying Social Work
• FOR anyone

New York State Indian Aid
https://www.c7.troy.edu/peasam/
• FOR full-time and part-time vocational and undergraduate students in New York State only

Society for American Archaeology
www.saa.org/career-practice/scholarships-and-grants/native-american-scholarships.html
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

Udall Scholarship Program
• FOR undergraduate students
• FOR enrolled members and descendants

United South and Eastern Tribes Scholarship Fund
www.unsetinc.org/resources/scholarships
• FOR undergraduate and graduate students
• FOR enrolled members only

Websites
Six Nations Financial Aid Directory:
www.buyfromthekids.ca/academicworks/native-american-suny-eastern-consortium
Financial Aid
Scholarship Resource Guide for American Indian/Alaska Natives Students:
Source of Financial Aid for Native American Students

Scholarship Program Policies and Procedures are subject to change without notice.
Revised November 2021.

Books
Financial Aid for Native Americans by Gail Ann Schlachter and R. Dennis Webster, most recent edition

Online Guide Books
College Board Indigenous College Planning Guidebook
professionals.collegeboard.org/pdf/indigenous-college-planning-guidebook.pdf
American Indian College Fund: Native Pathways College Going Guidebook
American Indian College Fund: Career Pathways
Career Roadmap Guidebook

Other Scholarship Organizations & Resources

Society for American Archaeology
www.saa.org/career-practice/scholarships-and-grants/native-american-scholarships-fund
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

Udall Scholarship Program
• FOR undergraduate students
• FOR enrolled members and descendants

United South and Eastern Tribes Scholarship Fund
www.unsetinc.org/resources/scholarships
• FOR undergraduate and graduate students
• FOR enrolled members only

Other Scholarship Organizations & Resources

Society for American Archaeology
www.saa.org/career-practice/scholarships-and-grants/native-american-scholarships-fund
• FOR undergraduate and graduate students
• FOR enrolled members and descendants

Udall Scholarship Program
• FOR undergraduate students
• FOR enrolled members and descendants

United South and Eastern Tribes Scholarship Fund
www.unsetinc.org/resources/scholarships
• FOR undergraduate and graduate students
• FOR enrolled members only

Websites
Six Nations Financial Aid Directory:
www.buyfromthekids.ca/academicworks/native-american-suny-eastern-consortium
Financial Aid
Scholarship Resource Guide for American Indian/Alaska Natives Students:
Source of Financial Aid for Native American Students

Scholarship Program Policies and Procedures are subject to change without notice.
Revised November 2021.

Books
Financial Aid for Native Americans by Gail Ann Schlachter and R. Dennis Webster, most recent edition

Online Guide Books
College Board Indigenous College Planning Guidebook
professionals.collegeboard.org/pdf/indigenous-college-planning-guidebook.pdf
American Indian College Fund: Native Pathways College Going Guidebook
American Indian College Fund: Career Pathways
Career Roadmap Guidebook

Scholarship Program Policies and Procedures are subject to change without notice.
Revised November 2021.